SAP2000 v24.0.0 Release Notes
© 2022 Computers and Structures, Inc.

Notice Date: 10-March-2022
This document lists changes made to SAP2000 since v23.3.1, released 24-September-2021. Items marked
with an asterisk (*) in the first column are more significant.
Analysis
Enhancements Implemented
*
*

Ticket
7077

*

7783

*

8082

Description
An enhancement was made to allow the disabling of the coupling between major bending,
shear V2, and torsion for Channel and General sections, including the cold-formed C and Hat
sections. The new option to control this coupling effect of the shear center is available in the
affected section-property definitions. Consideration of the shear center is enabled by
default.
The meshing of frame objects that contain tendons has been changed to generally improve
accuracy but also to reduce the size of the analysis model. Previously, any frame object that
contained one or more tendon mesh points was discretized based on the minimum
discretization anywhere along the length of any tendon that contained a point in that frame.
That could lead to over-meshing of frames, yet did not necessarily mesh the frames at the
tendon points. It also affected adjacent frame objects if a tendon point was at the end of the
frame object, even if the tendon did not pass through that frame. Now, frames are meshed
only at the contained tendon points, regardless of the discretization elsewhere in the
tendon. Only interior points are considered, so adjacent frame objects are not affected.
Note that frame objects containing a tendon point will only be meshed if the frame is a
member of the group loaded by that tendon, as specified in the tendon definition. Area and
solid objects are not meshed at tendon points and are not affected by this change. Tendon
points that affect frame meshing are the control points used to define the tendon geometry,
as well as additional points created to satisfy the minimum discretization specified for the
tendon. Frame discretization due to tendons will not create elements smaller than 1/8 of
the smaller cross-sectional dimension (t2 or t3) of the frame object, subject to an absolute
minimum of 10 times the Auto Merge Tolerance (File > Settings > Dimensions). Affected
models run in the new version may exhibit a very small effect upon the results, generally of
no engineering significance, unless the model is unstable or ill-conditioned. Verification
Example 1-009 has been updated to reflect the new results, which are now approximately
50% closer to the benchmark values.
A change has been made to how equilibrium errors are checked for convergence in
nonlinear static load cases. Previously, the relative contributions of force unbalance to
moment unbalance were dependent upon database length units. This tended to overemphasize moments for small length units (mm, inch), which are the default database units.
In certain cases, this could lead to larger force equilibrium errors than expected based on
the relative convergence tolerance specified for a load case (the default is 0.0001). Now
these equilibrium measures are independent of length units, and they are better balanced
between force and moment for typical structural dimensions. Because of this change, the
results of nonlinear static load cases may differ when run in the new version compared to
the previous version. Generally any change will be small, but it may be more significant for
sensitive or ill-conditioned models. Note that nonlinear static analysis is an approximate,
iterative process. Results should be confirmed by engineering judgment, and re-running
certain load cases using progressively smaller convergence tolerances may be necessary to
get the expected equilibrium for some models. Results for non-iterative, event-to-event load
cases should not be affected, except that the reported error at the end may differ.
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API
Enhancements Implemented
*

Ticket
6852

Description
An enhancement has been implemented for the Application Programming Interface (API) to
add a new function, SectCut.Delete, to allow deleting a section cut.

Data Files
Enhancements Implemented
*

Ticket
7906

8168
8173

8190

Description
The following changes have been made to the Chinese materials library: (1.) Tendon
materials in accordance with the JTG D62 and TB codes have had their yield and tensile
stress values adjusted. (2.) New tendon material grade JTGD62 fpk1960 was added. (3.)
Tendon materials in accordance with GB 50010 have been added.
The Russian material library has been updated to add materials from the latest standards SP
63.13330.2018 (concrete, rebar, tendon) and SP 63.13330.2017 (steel). The materials from
the older standards, available previously, are still present in the updated library.
Two new Russian frame section libraries have been added to conform to the latest
standards. These files are Russian2020_en.XML and Russian2020_ru.XML. The former
contains the frame sections with names in the English language, and the later contains the
same frame section with names in the Russian language, where applicable.
The handling of functions (time history, response spectrum, steadystate, and power spectral
density) defined in external data files has been enhanced to: (1.) Significantly speed up
reading of function data files with many data points, and (2.) Allow users to suppress error
messages caused by multiple missing function data files when running the analysis.

Database Tables
Enhancements Implemented
*

Ticket
7482

Description
An enhancement has been made to the aluminum frame design codes AA 2015, AA 2020, EN
1999:2007 and cold-formed frame design codes AISI-16 and Eurocode 3 1-3 2006 to include
the description for field names of the associated design display tables.

Design – Aluminum Frame
Enhancements Implemented
*

Ticket
7660

Description
An enhancement has been made to provide clarification for the location of load application
in the aluminum frame design overwrites for the AA 2015/2020 and EN 1999:2007 codes,
and in the cold-formed frame design overwrites for EN 1993-1-3:2006 code. The item
descriptions in the respective design overwrites forms have been updated for this purpose.

Design – Cold Formed Frame
Enhancements Implemented
*

Ticket
7324

Description
An enhancement has been made to the EC3 1-3 2006 cold-formed frame design to offer
design preference and design overwrite options to select different sets of combination
equations to be considered for member buckling. In addition, all the demand-capacity ratio
and combination equations are now displayed in the right-click design report.
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Design – Concrete Frame
Enhancements Implemented
*

Ticket
7061
7379

7380

7407

7503

*

8061

Description
An enhancement has been made to the EC 2-2004 concrete frame design to calculate the
extra longitudinal reinforcement required due to shear according to equation 6.18 in Section
6.2.3(7) of the EN 1992-1-1:2004.
An enhancement has been made to the concrete frame design codes in which
IgnoreBeneficialPuInBeamDesign, ConsiderTorsion, and TanTheta are now available to the
Preferences and the Overwrites forms. Previously IgnoreBeneficialPuInBeamDesign was
available in the Preferences forms, and ConsiderTorsion and TanTheta were available
through the Overwrites form for specific codes. IgnoreBeneficialPuInBeamDesign applies to
beams, while ConsiderTorsion and TanTheta apply to both beams and columns. These
parameters are code-specific.
An enhancement was made to the concrete frame design code "Eurocode 2-2004" where
now the optimized Theta value is used for shear design even when the minimum governs.
Previously optimized Theta was only used for design when the minimum did not govern.
Now the computed value of VRd,s and VRd,max are always based on the optimized
Tan(Theta).
An enhancement has been made to the concrete frame design code "ACI 318-19" to allow
control of either including or excluding axial compression in the flexural design of beams if
the axial compression reduces the required reinforcement. Axial tension and axial
compression that increase the required flexural reinforcement are always considered. This
option to exclude beneficial compression is accessed through the concrete preferences and
overwrites for the "ACI 318-19" code.
A change has
been made to ACI 318-19 concrete frame design where the factored design torsion (Tu) is no
longer increased to phi*Tcr if it is greater than phi*Tth. The previous implementation was
too conservative for determinate structures and
for structures where torsion redistribution was not done. If redistribution is desired,
torsional stiffness modifiers can be applied to obtain the desired Tu.
Concrete frame design has been added per the Canadian CSA A23.3-19 code.

Design – Slab
Enhancements Implemented
*
*

Ticket
1007

Description
Several enhancements have been made to the Concrete Shell Design in accordance with
Eurocode 1992-1-1:2004: (1.) Concrete shell design has been moved to the Design menu.
(2.) Design Preferences can be used to specify several design parameters, including the
national annex. (3.) The design now includes iteration to calculate the design thickness of
the outer layers and to determine the optimum amount of reinforcement. (4.) Design can
now be performed for a single layer of reinforcement, assumed to be at mid-thickness, as
well as for two layers (top and bottom reinforcement). (5.) Design is available for shells with
variable thickness under the assumption that the cover remains constant within each
element. (6.) Graphical display of the design results has been enhanced to provide more
detailed information. (7.) Design results are now available in the database tables. Tabular
results can be presented as envelopes, step-by-step, or with correspondence, depending
upon the types of load cases and load combinations selected.
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Design – Steel Frame
Enhancements Implemented
*

Ticket
7231

*

7460

7842

*

8129

Description
An incident was resolved where frame element forces used for frame design and reported in
the "Design Force Data" tables did not account for all of the load cases referenced in
selected design load combinations when such design load combinations included modal or
buckling load cases. Now any modal or buckling load cases included in load combinations
used for design will simply be ignored and the effects of other load cases will be correctly
considered; previously the effects for other load cases could be affected by the presence of
the modal and buckling load cases in the load combinations. Analysis results for frame forces
and stresses as plotted and tabulated were not affected.
An enhancement has been made to reconcile the design axis notations to the Eurocode 32005, Italian NTC 2008, and Italian NTC 2018 steel design codes, EN 1999:2007 aluminum
design code, and Eurocode 3 1-3 2006 cold-formed design code. Previously, major and minor
axis notations were used. They are now changed to Y-Y and Z-Z. Changes have been made to
affected column headings the following database tables: (1.) For Eurocode 3-2005, Italian
NTC 2008, and Italian NTC 2018 steel design codes: "Overwrites - Steel Design", "Steel
Design 1 - Summary Data", "Steel Design 2 - NMM Details", "Steel Design 3 - Shear Details",
and "Steel Design 7 - Beam Shear Forces". (2.) For the EN 1999:2007 aluminum design code:
"Overwrites - Aluminum Design", "Aluminum Design 1 - Summary Data", "Aluminum Design
2 - Axial Details", "Aluminum Design 3 - Flexural Details", Aluminum Design 3 - Shear
Details". (3.) For the Eurocode 3 1-3 2006 cold-formed design code: "Overwrites - Cold
Formed Design", "Cold Formed Design 1 - Summary Data", "Cold Formed Design 2 - Axial
Details", "Cold Formed Design 3a - Major Flexural Details", "Cold Formed Design 3b - Minor
Flexural Details", "Cold Formed Design 4 - Shear Details". In addition, the tables "Cold
Formed Design 3a - Major Flexural Details" and "Cold Formed Design 3b - Minor Flexural
Details" have been renamed to "Cold Formed Design 3a - Flexural Details Y-Y" and "Cold
Formed Design 3b - Flexural Detail Z-Z", respectively.
For steel frame design per the Eurocode 3:2005, Italian NTC 2008, and NTC 2018 codes, and
for aluminum frame design per the Eurocode 9:2007 code, the values of the geometrical
moments of inertia I22, I33, I23 are reported for angle sections in addition to the principal
moments of inertia Iy, Iz, and Iyz (= 0). For all other sections, only Iy, Iz, and Iyz are shown.
An enhancement was made to add Steel frame design based on Canadian code CSA S16-19.

Documentation
Enhancements Implemented
*

Ticket
7012

7288

Description
Design manuals shipped with the software have had chapters or sections that document the
design preferences and overwrites removed in favor of the documentation that is already
provided directly inside the software on the design preferences and overwrites forms
themselves. Note that this had already been done for some of the manuals in previous
releases.
The steel frame design manual for the Russian steel frame design code "SP 16.13330.2017"
has been updated to clarify the use of the Reliability factor (Gamma_n) and the Working
conditions factor (m_tr). These factors were already used for design calculations, and only
the documentation has been updated.
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External Import and Export
Enhancements Implemented
*

Ticket
5690

7626

Description
An enhancement has been made to the export of models with curved frames to .DXF files.
Frame objects curved along a circular arc, which were exported as AutoCAD line objects in
previous versions of SAP2000, are now exported as AutoCAD arc objects. In addition, each
extruded frame
object is now exported as a single CAD object, instead of one object for
each face, as was the case in previous versions.
An enhancement to the export of models as CIS/2 Step files has been implemented. Labels
and names of exported objects and definitions containing non-ASCII characters are now
exported with the ISO 10303-21 and ISO 10646 encoding of the non-ASCII characters.
Previously, such label and names were exported with the non-ASCII characters replaced with
their closest ASCII equivalents.

Graphics
Enhancements Implemented
*

Ticket
1523

7115
8100

8104
8146

Description
The extruded view of the undeformed shape now supports nonprismatic Section Designer
(SD) sections under the following conditions. These conditions, and the resulting plot, apply
on a segment-by-segment basis along the non-prismatic section: (1.) For the segment, the
beginning and end sections must both be SD sections; (2.) The SD sections at both ends of
the segment must contain the same number of shapes, defined in the same order; (3.)
Corresponding shapes must be of the same type; and (4.) Corresponding polygon shapes
must contain the same number of points. Previously, nonprismatic SD Sections were
represented with rectangular extruded shapes based on the bounding dimensions of the
section at each end of each segment. This will still apply to those segments of nonprismatic
sections containing SD sections that do not meet the conditions stated above.
An enhancement was done to allow specifying grid bubbles to be shown on both ends of the
grid line at the same time.
An enhancement was made to add an option to turn ON/OFF showing of frame-section
thicknesses in extruded views of thin-walled sections. Turning this OFF can speed up the
display and reduce the size of printed files. In addition, and option has been added to
control the frame edge color for extruded views, which can be adjusted as needed for
clarity.
An enhancement was made to remove internal shading when printing frame extruded views
in DirectX graphics mode. This speeds up printing and reduces file size when printing to PDF.
An enhancement was made to change the printing resolution from from 100 to 300 DPI. This
should especially improve print quality on PDF printers, with limited effect on file size.

Installation and Licensing
Enhancements Implemented
*
*

Ticket
7222

Description
The version number has been changed to v24.0.0 for a new major release.

SAP2000 v24.0.0

ISO #RELSAP2400

10-Mar-2022

Page 5 of 16

Loading
Enhancements Implemented
*

Ticket
7782

Description
An enhancement has been made for the default loading combinations for Chinese Design
codes based on changes in the "General Specification for Seismic Resistance of Buildings and
Municipal Works", GB55002-2021, Section 4.3.2. The gravity load factors, when combined
with seismic loads, have been changed from 1.2 to 1.3, and the seismic load factors have
been changed from 1.3 to 1.4. Additionally, in accordance to "General Specification for Steel
Structures", GB55006-2021, Section 5.2.3, a factor of 0.5 is applied to notional loads in load
combinations that include seismic loads.

Results Display and Output
Enhancements Implemented
*

Ticket
7811
7840

Description
An enhancement was made to speed up recovery of frame forces for tables and the API
(Application Programming Interface).
Steel frame design has been enhanced to display multiple D/C ratios along with consistent
colors. Previously, the color displayed was always based on the P-M ratio, even when
showing the numerical value for a different D/C ratio. Now the color is consistent with the
displayed ratio. A new display of Max Ratio has been added to envelope all the D/C ratios for
a given member. The following D/C ratios can now be displayed: (a) Max Ratio Colors &
Values (absolute maximum DC ratios over all checks), (b) Max Ratio Colors/No Values, (c) PM Ratio Colors & Values (maximum from strength and buckling P-M checks), (d) Shear (or
Average Shear) Ratio Colors & Values, (e) Max Shear Ratio Colors & Values, (f) Equivalent
Ratio Colors & Values, (g) Identify all Failures. All items except (e) and (f) apply to all steel
frame design codes, whereas the items (e) and (f) apply to only the "SP 16.13330.2017" and
"Indian IS:800-1998" codes. No design results have changed.

Structural Model
Enhancements Implemented
*

Ticket
1524

*

7566

Description
An enhancement was implemented to report the shear center location for certain framesection properties. This value may be reported even in cases where it is not used for
analysis. The shear center is only used for shear V2; only for Channel, General, cold-formed
C and cold-formed Hat sections; and only if the option to consider the shear center is
selected (see Ticket 7077 for this release).
AS3600-2018 is added to the types of time-dependent material properties available for
concrete materials, supporting creep, shrinkage, and age-dependent stiffness behavior.

User Interface
Enhancements Implemented
*

Ticket
2482

7238

Description
An enhancement has been made for steel, concrete, cold-formed steel, and aluminum frame
design where now the Design Overwrites forms offer an additional choice for decision-type
(Yes/No) overwrite items. The previous choices were “Yes” and “No”. The new choices are
now “Yes”, “No”, and “Program Determined”. The new “Program Determined” option allows
easily returning to the default value after the overwrites have been changed. Design results
for existing models are not affected unless the design overwrites are changed.
An enhancement was made to the display of frame property data to additionally show the
location of the centroid and section moduli both on the positive and negative sides, as well
as the warping constant when it has been computed.
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*

Ticket
7282

Description
The analysis log can now be displayed using the Show Log button on the Analysis Message
form which appears after running an analysis that generates warning or error messages, or
later using the command Analyze > Show Analysis Messages. This is the same analysis log
that can be displayed directly using the command Analyze > Show Last Run Details.
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Analysis
Incidents Resolved
*
*

Ticket
7502

7936
*

8206

Description
An incident was resolved where nonlinear static and staged-construction load cases could
converge with equilibrium errors that were larger than expected when large external loads
were applied. When this occurred, the errors were typically in a direction or region of the
model not significantly affected by the external load. For example, horizontal reactions in
one portion of the model may be out of balance due to large vertical loading in a different
region of the model. The effect of this error was negligible for most models. Now
equilibrium convergence is measured using the relative convergence tolerance times the
magnitude of the internal forces, rather than the previous approach of considering the
larger of the internal and external forces. This change will have no impact on most models,
and will tend to increase iteration and improve equilibrium for other models. A few models
that previously converged may now fail to converge under the tightened equilibrium
requirements; this can usually be resolved by improving the stability or conditioning of the
model. Note that the behavior of the pure event-to-event solution strategy is not affected
by this change, except that the reported equilibrium error could be larger; no other results
will be affected.
An incident was resolved where the analysis failed to run on moderate- to large-sized
models with a very large number (more than a thousand) of nonlinear static or staged
construction load cases. When this occurred, results were not available.
An incident was resolved where running a steady-state or power-spectral-density (PSD) load
case with no effective applied loads caused a fatal analysis error. When this occurred,
analysis results were not available.

API
Incidents Resolved
*

Ticket
7261

7598

7647

Description
An incident was resolved for the Application Programming Interface (API) that addressed
several issues: (1.) For the functions relating to concrete frame design overwrites, the
moment coefficient Cm, and also moment factors Dns and Ds for the Eurocode 2-2004 and
NTC 2008 codes, were all available even though those factors were not used anywhere in
the design. This has been resolved by returning 1 from the API functions indicating that the
function did not successfully execute when these values are requested. (2.) The API function
for effective length factor, Beta, has also been corrected to check whether or not the frame
section is of column-design type. If the frame section is column design type, the API
functions will be executed and the value of the effective length factor will be retrieved or
assigned to the frame element, appropriately. Otherwise, the functions will return 1
indicating that they were not successfully executed. (3.) The frame type can be set to have a
value ranging from 1 to 4 corresponding to DC High, DC Medium, DC Low, and Secondary for
Eurocode 2-2004, and from 1 to 3 corresponding to DC High, DC Low, and Secondary for NTC
2008. Previously, it could only be set to Sway or Non-sway for both design codes.
An incident was resolved for the Application Programming Interface (API) where the value of
the coordinates of load application (za) and shear center (zs) were not properly set using the
function SetOverwrite for Eurocode 3-2005, NTC2008, and NTC2018 steel-frame design
codes. Similarly, the value of the coordinate of load application was not correctly set using
the API function SetOverwrite for the AA 2015, AA 2020, and EC9 2007 aluminum-frame
design codes and Eurocode 3 1-3 2006 cold-formed frame design codes. All these values are
now properly set via the API function SetOverwrite and used for the design procedures.
An issue was resolved for the Application Programming Interface (API) where the functions
SapObject.SapModel.LoadCases.StaticNonlinearStaged.GetMassSource and
SapObject.SapModel.LoadCases.StaticNonlinearStaged.SetMassSource always returned 1
(error) when called, and did not perform their intended function. This issue has been
resolved so that the API functions behave as intended.
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*

Ticket
7849
8101

Description
An incident was resolved for the Application Programming Interface (API) where the
function LinkObj.SetGroupAssign was not assigning the link object to a group when used in
the cross-product API. This did not affect the implementation in the SAP2000 API.
An incident was resolved for the Application Programming Interface (API) where frame
section properties imported by using the function SapModel.PropFrame.ImportProp may
produce a frame section with property modifiers set to zero (0). This behavior has been
corrected and imported properties will have property modifiers set to the default value of
one (1).

Data Files
Incidents Resolved
*
*

Ticket
7763

8130

Description
An incident was resolved where the depth and width of unequal angles imported form
AISC15.xml, AISC15M.xml, AISC15.pro, and AISC15M.pro libraries were switched.
Consequently, the program was showing the longer leg as horizontal but the section
properties in the database were based on the longer leg being vertical. This was an issue in
the section database itself and has now been addressed. No other section libraries were
affected by this bug. Older files that use unequal angles from the AISC15 databases will have
the error corrected when opened in the new version by reimporting the section. Older
versions of the program can replace the AISC15 databases in their section libraries and
reimport any unequal angles used in the models.
An incident was resolved where the material data for the Spanish region was not available
for versions 23.3.0 and 23.3.1. This was caused by an invalid character in the library file that
has now been fixed. Note that the corrected library file also includes corrections to the
thermal coefficients as previously reported for v23.3.0 under Ticket 7174.

Database Tables
Incidents Resolved
*

Ticket
7512

*

7539

7653

7893

Description
An incident was resolved where the load cases selected for tabular output may not be saved
correctly in models that include response spectrum load cases with nonzero diaphragm
eccentricity and at least one rigid diaphragm assignment.
An incident has been resolved where the Eurocode 1999:2007 aluminum frame design
tables exported to Excel and displayed or printed in Word was not working. For Excel, this
was caused by the presence of a colon (:) in the sheet names, which has now been changed
to a dash (-). For the Word RTF files, some of the tables had too many columns to fit on a
page; now they will break into smaller tables as needed.
An enhancement was made to improve the error messages displayed when the import of
database table "Groups 2 - Assignments" fails due to invalid data. Previously the import was
aborted with no useful information as to why. This change affects the direct import of
database files and interactive database editing.
An incident was resolved where the Between and Not Between commands for Text fields in
the Quick and Basic filters were missing some single quotes. For example, the generated
command would be {Joint > '2 And Joint < 4'} instead of {Joint > '2' And Joint < '4'}, where
the {} characters are not included.
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Design – Cold Formed Frame
Incidents Resolved
*

Ticket
7896

8050

Description
An incident was resolved for cold-formed steel frame design and aluminum frame design
where explicit bracing points defined as point and/or uniform bracing (command Design >
Lateral Bracing) were not being considered when unbraced length determined from
connectivity and support for buckling about the minor (or Z-Z) axis or for lateral-torsional
buckling was longer than the frame member itself. The bracing points were properly
considered for the case where the program-determined unbraced length was less than or
equal to the member length.
An incident has been resolved for Eurocode 3 1-3 2006 cold-formed frame design in which
the demand-capacity ratio calculated by equation 6.26 was shown as a negative value. It is
now displayed by its absolute value. The design results are not affected.

Design – Concrete Frame
Incidents Resolved
*

Ticket
6625
6903

7277

7545

7816

7995

8185

Description
An incident was resolved in the Chinese 2010 concrete frame design to now report T/Wt
correctly in the design details output. This was a reporting issue only and did not affect the
design results.
An incident was resolved for concrete frame design codes "Eurocode 2-2004" and "Italian
NTC 2008" where the beam/column capacity ratio was not being calculated for ductile
moment-resisting frames ("DC High" and "DC Medium" for "Eurocode 2-2004" and "DC
High" for "Italian NTC 2008"). This error only affected versions 23.2.0 to 23.3.1. The error
was obvious since there was no output for the beam/column capacity ratio.
An incident was resolved in the concrete frame design manual for the Canadian concrete
frame design code "CSA A23.3-14" where the factors in the expressions of the minimum
shear rebar requirements were incorrect. Instead of using the expected factors of 0.06, no
factor was used on page 3-24, and factor 0.6 was used on page 3-50. This was a
documentation issue only. No results were affected.
An incident was resolved for “ACI 318-19” concrete frame design where the minimum top
longitudinal rebar for flexural design was too conservative for all T-beams of all framing
types if there was any negative moment. Previously, the minimum was enforced in these
cases based on the assumption that bw was the smaller of 2*b and b_flange, per Section
9.6.1.2 of “ACI 318-19” code. But the use of this enlarged bw is actually only required for
statically determinate T-beams where the flange is in tension, per Section 9.6.1.2. Now this
enlarged bw is only used for cantilever T-beam where the flange is in tension.
An incident was resolved in the Russian concrete frame design code SP 63.13330.2011
where the “Snow Load Duration Factor” preference was not taken into account when doing
a crack design check. The whole snow load was being considered as a short-term one. In
addition, the phi3 factor is
now taken to be 1.2 when an axial force is either zero or when axial compression is less than
0.01*Rb,n*Ag.
An incident was resolved for the Indian concrete frame design code "Indian IS 456-2000"
where the section depth for Section Designer (SD) sections was taken as 2 * sqrt(3) * r,
where r is the radius of gyration in the respective direction. This approximation affected
calculation of the slenderness limit per IS 25.1.2 and calculation of the additional moment
per IS 39.7.1. Now the design will consider the depth as the full section dimension in the
respective direction. Previously the behavior was correct for rectangular SD sections,
conservative for I-shaped SD sections, and unconservative for diamond-shaped SD sections.
An incident was resolved for Russian SP 63.13330.2012 concrete design code where design
tensile strength of concrete was computed incorrectly by not accounting for gamma_b5
factor for R_bt,long and R_bt,short.
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Design – Steel Frame
Incidents Resolved
*

Ticket
5874
5996

6393

7151

*

7256

7546
7744

7774

Description
An incident was resolved for steel frame design code "Chinese 2018" in which some of the
section numbers of relevant Chinese codes in the reported error messages were incorrect.
This was a reporting error only. No other results were affected.
An incident was resolved in steel frame design codes "Eurocode 2-2005" and "Italian NTC
2018" in which the torsional strength for hollow box shapes was miscalculated. From elastic
theory, the torsion strength of such sections is defined by the following equation: T,Rd =
tau_rd*(2*Ao*t) where tau_Rd is the maximum allowable shear stress that, for steel
members, is approximated by eta* (fy/gamma_0)/sqrt(3) for non-slender sections and chi*
(fy/gamma_0)/sqrt(3) for other section (EN 1993-1-5:2006 Section 5.3, Table 5.1); Ao is the
area enclosed by the centerline perimeter; and t is the thickness of the section. Ao was
being taken as Ao = (bf – tf) * (h – tw). This has been corrected to Ao = (bf – tw) * (h – tf).
There was no error for sections with constant wall thickness, and only a minor effect if the
thickness of the webs (tw) was different from that of the flanges (tf).
An incident was resolved for steel frame design codes "Eurocode 2-2005" and "Italian NTC
2018" where the resultant stress ratio reported on the Steel Stress Check Information form
did not match the sum of the component ratios reported. This happened when torsion was
dominant as its component ratio was not reported. This has now been improved. Moreover,
for the "Italian NTC 2018" code, the reported interaction equation name was incorrect in the
detailed report when the governing equation was "EC3 6.2.7(1)-6.23". This was a reporting
issue only. The actual calculations and design results were correct.
An incident was resolved for Russian steel frame design code "SP 16.13330.2017" in which
the member color displayed in the "Steel Stress Check Information" window was based on
the maximum stress ratios considering P-M interaction, maximum shear stress, and
equivalent stress ratios. However, the reported text said that the color was based on the PM interaction ratios. The "Steel Stress Check Information" form has been updated to include
maximum shear stress and equivalent stress ratios. The "Display Steel Design Results" form
has been updated to include the following items in the design output section: "Max Ratio
Colors & Values", "Max Ratio Colors/No Values", "Max Ratio Colors/P-M Values", "Max Ratio
Colors/Average Shear Ratio Values", "Max Ratio Colors/Max Shear Ratio Values", and "Max
Ratio Colors/Equivalent Ratio Values". The calculated P-M ratios for the equations "SP 8.2.3
Eq. 51" and "SP 9.1.1 Eq.105" have also changed for the circular sections as the bending
components are now subjected to the square root of the sum of squares.
An incident has been resolved in which the warping constant Cw was computed incorrectly
for double-channel and double-angle sections. It is now calculated appropriately with the
assumption that it is the contribution of Cw from two single channels or two single angles
for the double channel and double angle, respectively.
An incident was resolved where an error condition occurred designing an eccentrically
braced frame if the design loading combination contained an enveloping load case or
combination.
An incident was resolved for steel frame design where the warping constant (Cw or Iw) was
not reported for the Tee, Angle, and Double Angle sections in the AISC 360-16, AISC 360-10,
AISC 360-05, AS 4100-1998, CSA S16-14, CSA S16-09, Eurocode 3-2005, Indian IS 800:2007,
Italian NTC 2018, Italian NTC 2008, KBC 2016, KBC 2009, NZS 3404:1997, SP 16.13330.2017,
and SP 16.13330.2011 design codes. This was a reporting error only, and no design results
were affected. Note that the value may be displayed as "Not Required" in cases where is it
not used by the design code or has an insignificant effect for the section type.
An incident has been resolved for steel, aluminum, and cold-formed frame design in which
the Make Auto Select Section Null command now assigns the design section to the analysis
section for the next analysis run. Previously, the analysis section was not updated to be the
same as the design section for the next analysis run after the design was run for the first
time and the Make Auto Select Section Null command was selected.
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*

Ticket
7778

7790

*

7895

7930

8004

Description
An incident was resolved for the Russian steel frame design code "SP 16.13330.2017" in
which the phi_b factor was not being calculated correctly because the effective length L_eff
was taken as K_LTB * L_22 instead of K_LTB * L_LTB. In the default case where L_22 and
L_LTB are determined automatically from the framing condition, they are equal and the
results were not affected. However, for frame members for which point bracing or uniform
bracing were specified, or whose unbraced lengths were overwritten, then the values L_22
and L_LTB could be different, and the phi_b factor could have been incorrect.
An incident has been resolved in steel frame design codes "AISC 360-16", "AISC 360-10", and
"KBC 2016" in which the B1 factor was calculated based on the pure Euler buckling force Pe1
with unmodified EI instead of EI* when the Direct Analysis Method was used (AISC 360-16
Appendix 8.2.1, AISC 360-10 Appendix 8.2.1) with certain conditions. The results were
affected when Direct Analysis Method was used with Tau_b fixed or Tau_b variable for
either generalized second-order method or amplified first-order method of amplification.
The results were not affected when Direct Analysis Method was not used or when Direct
Analysis Method was used but no modification was assigned in the preferences. The
resulting PMM ratio was slightly unconservative.
An incident was resolved for steel frame design codes “Eurocode 3-2005” and “Italian NTC
2018” where the moment capacity reduction factor for shear, rho, was being miscalculated
as unity (1.0) for the case where V_Ed/V_pl,Rd < 0.5, but V_Ed/V_pl,T,Rd > 0.5. This affected
the calculation of M_y,V,Rd. When V_Ed/V_pl,Rd > 0.5, or when V_Ed/V_pl,Rd < 0.5 and
V_Ed/V_pl,T,Rd < 0.5, the calculated rho factors were correct. However, the minor-direction
rho factor was incorrectly reported to be the same as the major direction rho factor. In
addition, and for the “Italian NTC 2018” code only, the value of eta was always taken as 1.0
when calculating V_pl,Rd and V_Ed/V_pl,T,Rd. Now eta is taken as 1.2 for fy less than or
equal to 460 MPa and as 1.0 for fy greater than 460 MPa. The calculation of eta remains
unchanged for the “Eurocode 3-2005” code. The result was on the unconservative side. The
effect of these errors tended to be unconservative.
An incident has been resolved for the steel frame design code "SP 16.13330.2017" where
the phiB calculation was not correct for singly-symmetric I-shapes under certain conditions:
(a) the shape was a singly-symmetric I-shape, (b) the narrower flange was under
compression, (c) nCoeff = I1 / (I1 + I2) < 0.7, i.e., the flanges were not very different, (d)
Leff_LTB > 5*b2, where b2 is the width of the narrower flange, and (e) bending moment was
significant in the member. If all these conditions were met, then Phi2 calculated with
equation SP 16.13330.2017 G.4 Eq. (G.7) should not be modified per section SP
16.13330.2017 Annex G.6. However, Phi2 was being modified per section SP 16.13330.2017
Annex G.6 for all cases. The effect was that Phi2 was being modified by a factor (1.025 0.015 * LeffOverb2) when it should not have been, and eventually PhiB was reduced per
section SP 16.13330.2017 Table G.3. The results were slightly conservative for such a case.
An incident was resolved for the steel frame design code “Chinese 2018” where the
determination of Beta_t was not correct when there was a uniformly distributed lateral load
on the span of the member. The value was correct when there was no lateral load on span
or when there were one or more concentrated lateral loads on the span.

Documentation
Incidents Resolved
*

Ticket
7581

Description
An incident was resolved where the Help topics for the Advanced Foundation property
incorrectly indicated that the soil springs created along the lengths of piles, pile piers, and
shafts were of the type compression-only, when in fact they are linear springs that support
tension and compression. Compression-only springs are only generated at the bottom and
edges of footings and pile caps.
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External Import and Export
Incidents Resolved
*

Ticket
7558

7637

7666

Description
An incident was resolved that addressed several issues affecting the import of CIS/2 Step
files: (1.) CIS/2 Step files containing print-control directives or character strings containing
escape sequences specifying non-ASCII characters encoded per the ISO 10646 standard
could not be imported into SAP2000. When this occurred, no imported model could be
created. (2.) Character strings containing escape sequences specifying non-ASCII characters
encoded per the ISO 8859 were imported without any conversion of the escape sequences
into the characters they specified. When this occurred, the error had no impact on the
results. Only the labels of imported entities were affected. (3.) As an enhancement, the error
messages reporting fatal errors encountered while SAP2000 first parses a CIS/2 Step file now
include the line number of the problematic line. Note that these error messages are distinct
from other error messages reporting incomplete or otherwise incorrect entity definitions in
the CIS/2 Step files, which already include the problematic entity number.
An incident affecting the export of models to CIS/2 Step files was resolved. SAP2000
exported all model point objects and frame objects, even when the Export Selected Objects
option in the Create CIS/2 STEP File form was chosen. This affected all versions of SAP2000
capable of exporting models to CIS/2 Step files. SAP2000 now exports only the selected
point and frame objects, plus their connected point objects, when the Export Selected
Objects Only option is chosen.
An incident affecting the import of IFC files was resolved. IFC files with comments containing
forward slashes could not be imported. This affected all versions of SAP2000 capable of
importing IFC files. When the problem occurred, nothing was imported and the issue was
obvious. Editing out the problematic comments from the IFC file in a text editor made it
possible to import the file. IFC files with comments containing forward slashes are now
correctly imported.

Graphics
Incidents Resolved
*

Ticket
7206
7716

7904
8125

Description
An incident was resolved where displaying the cable applied loads using the "Display > Show
Object Load Assigns > Cable" menu command could result in an error when the loads were
shown in certain coordinate systems, including the "Current Display System".
An Incident was resolved that corrected several issues affecting the display of curved
members. These were display issues only, and no results were affected: (1.) Curved frame
objects with non-prismatic sections were displayed with a jagged section profile that
repeated the full non-prismatic variation multiple times along their lengths. They are now
displayed with the correct section variation along their lengths. (2.) In views for which the
Shrink Objects option had been selected, curved frame objects were each displayed as series
of shrunken disjointed lines instead of a single continuous curve. They are now displayed as
continuous curves. (3.) In views displaying frame-object end-offset assignments, curved
frame objects were displayed as straight lines when the graphics mode was DirectX. They
are now displayed as curves in such views, irrespective of the graphics mode.
An incident was resolved where when displaying frame releases in DirectX graphics mode all
frames would be shown shrunken instead of only those with releases.
An incident was resolved that addressed the following issues related to the display of
deformed shape when viewing the model in a user-defined coordinate system that was not
parallel to the Global system: 1. For both DirectX and GDIPlus graphics modes, the extruded
thickness direction was wrong for area (shell) objects. 2. For both DirectX and GDIPlus
graphics modes, frame joint offsets were plotted in the wrong direction. 3. For both DirectX
and GDIPlus graphics modes, the joint displacements were plotted in the wrong direction. 4.
For DirectX graphics mode, the snap location at the deformed joints was wrong, making it
difficult to view the displacement values under the mouse cursor. 5. For DirectX graphics
mode, the axes at the origin were drawn in the were wrong direction.
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Loading
Incidents Resolved
*

Ticket
7078

7170

7876
8099

*

8134

8158

Description
An incident was resolved where torsional load assigned to a frame member that was
modeled as a truss element was not transmitted to the rest of the model for linear load
cases, and hence the assigned load was effectively lost. By way of background, any frame
element is automatically treated as a truss element if all the following conditions are met:
(1) Both moments M2 and M3 are released at both ends, (2) torsion T is released at either
end, (3) there are no end offsets, and (4) the insertion points are at the centroid of the
frame section. Truss elements only have 6 force degrees-of-freedom, whereas regular frame
elements have 12 degrees-of-freedom: 6 forces and 6 moments. Now an additional check
has been added: if the load assigned to a frame element generates any torsional moment at
the unreleased end, then that element will not be treated as a truss member and all 12
degrees-of-freedom will be included in the model. In this case the unreleased end must
connect to other members with rotational stiffness in order to provide a stable structure
and load path. This error affected linear load cases and both linear and nonlinear modal
time-history load cases. Nonlinear static, staged-construction, and nonlinear directintegration time-history load cases were not affected. Frame objects that meet the truss
conditions but then are auto-meshed will create frame elements for analysis that do not
meet these conditions due to moment continuity within the object, and hence auto-meshed
frame objects were not affected by this error. This error affected versions v20.2.0 to v23.3.0.
This error was not common.
An incident was resolved where, in very flexible diaphragms, the assumed distribution of
wind load based on a semi-rigid diaphragm could excite local behavior, appearing as if a
small eccentricity had been introduced. A better distribution that includes the extreme
points is now implemented. Equilibrium was always satisfied.
An incident was resolved where an error was generated when attempting to run a multistep load case containing an auto-wind load pattern that only had one wind angle (step).
An incident was resolved where the NBCC 2015 auto wind load based on the dynamic
procedure was incorrect. The calculated pressure on leeward side was using the windward
height instead of one-half of the distance from the input bottom story or minimum level to
the input top story or maximum level.
An incident was resolved where the behavior of an area element with a nonlinear layeredshell section property subjected to temperature loads was incorrect: (1.) In linear analyses,
temperature loads were applied in both in-plane translational degrees of freedom in
membrane- and shell-type layers even if the degrees of freedom were set as inactive. This
behavior has been corrected so temperature loads only affect the active degrees of freedom
of each layer. (2.) For a linear analysis where the stiffness of the layer was significantly
different from the elastic stiffness of the material property assigned to the layer, the
behavior of the layer under temperature load could be incorrect. This could occur if the
layer had inactive or nonlinear degrees of freedom and the material had a non-zero
Poisson's ratio, or if the linear analysis used the stiffness from the end of a nonlinear
analysis. The magnitude of the error was proportional to the difference between the
stiffness of the layer and the elastic stiffness of the material property assigned to the layer
and, in most cases, was small. This issue has been corrected. (3.) Nonlinear static load cases
with an Event-to-event only solution scheme could have additional equilibrium errors when
temperature loads were applied. This only occurred for nonlinear layered shells and has
been resolved. The behavior of other types of shells, such as the thin and thick shell, were
not affected by this issue.
An incident was resolved for the Eurocode 8-2004 vertical elastic response-spectrum
function where expressions 3.8, 3.9, 3.10, 3.11 were using a multiplier of 2.5 instead of 3.0.
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Results Display and Output
Incidents Resolved
*

Ticket
1056

7254
7511
*

7578
7841

Description
An incident was resolved where the stresses and strains reported in a degenerate solid
element (one with two or more corners connected to the same joint) could be different at
different element corners connected to the same joint. This was a reporting error only due
to the extrapolation used from the 2 x 2 x 2 internal Gauss integration points. This does not
otherwise affect the accuracy of the element or the results for the rest of the model. Note
that the tetrahedron (four unique joints) produces constant stresses and strains, and hence
was not affected. The pyramid (five joints), wedge (six joints), and transition (seven-joint)
elements were affected.
An incident was resolved where specifying two or more quadrilaterals in a section-cut
definition would not give any results. Section cuts defined with a single cutting quadrilateral
were not affected by this issue.
An incident was resolved where the legend in the Response Spectrum Curves form
incorrectly included a percent sign on the damping value.
An incident was resolved in which an abnormal termination could occur when attempting to
display the Tendon Response Form for a tendon with no assigned loads. This was not
common.
An incident was resolved where certain quantities, such as section properties, were reported
in the frame design details as zeroes when using larger length units because of a coarser
zero tolerance for display. This was a display issue only, and design results were not
affected. Changing to smaller length units for display would usually resolve the issue, and
the values were correctly displayed in the tables.

Structural Model
Incidents Resolved
*

Ticket
6914

7534

7559

7672

Description
An incident was resolved for where a only a single frame-section property was being created
for all the piles of all advanced-foundation properties, even if the pile-section dimensions
were not the same in the different advanced foundations. Results agreed with the model as
generated using the single frame-section property for all the piles. Models opened in the
new version can be corrected by reassigning the advanced foundation properties to the
connected joints. This process is not necessary if all advanced foundation properties use the
same pile section.
An incident was resolved where (1) if auto select frame sections were assigned to steel
members, and (2) an analysis and design were run that caused the design sections to be
different from the analysis sections, and then (3) the analysis was rerun without unlocking
the model, the software would give a message "There are no Load Cases to run." However,
the analysis sections were already changed to reflect the design. This has now been
corrected. Rerunning the model with or without unlocking the model will now cause any
existing results to be deleted first if the analysis section changes require load cases to be
run.
An incident was resolved where the shrinkage strain calculated using the Eurocode 2-2004
type time-dependent material property was larger than expected. This issue occurred due to
an extra square root in the calculation for the beta_ds factor. Analysis results were
consistent with the documentation, which was also incorrect. Both the shrinkage behavior in
analysis and the documentation has been corrected to be consistent with Eurocode 2-2004.
An incident was resolved where section moduli imported from xml property files for doublechannel sections were read in as zero and shown as such on the section properties form.
This did not affect any analysis result, including frame stresses shown in the display, as the
section moduli were recomputed. It was, however, substituted with a very small value in
design and resulted in an overstress condition error. No other type of section was affected
by this issue. This error got inadvertently introduced in v23.0.0 and did not affect earlier
versions. Also any model containing this error will have the section moduli automatically
recalculated and fixed when opened in v23.4.0. Affected versions are v23.0.0 to v23.3.1.
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*

Ticket
7944

Description
An incident was resolved where pipe section properties imported from library files were
being overwritten by properties calculated using nominal dimensions. This only occurred if
the pipe section was imported from a library in SAP2000 v23.1.0 to v23.3.1. Previous models
with pipe sections were not affected. Pipe sections in affected models will now have their
properties re-imported to be consistent with the library.

User Interface
Incidents Resolved
*

Ticket
7149

7786
7954

Description
An incident was resolved where an abnormal termination could occur when trying to change
the type of a load case from Modal to Response Spectrum or Time History if it was the only
Modal load case defined. Now this operation is prevented and a message is presented
indicating that it is not allowed. Because Response Spectrum and Time History load cases
depend on a Modal case, this operation requires more than one Modal load case to be
present in the model before one can be changed.
An incident was resolved where the "First Relabel Order" and "Second Relabel Order" items
in the Interactive Name Change form (accessed through the Edit menu > Change Labels
command) were not available when using any language other than English.
An incident was resolved where the font information for some of the items in the advanced
report setup was not being displayed and saved correctly.
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